
MS POWERPOINT-INRODUCTION                             Chapter- MS Powerpoint              

Module-2 

 

Mrs.VARSHA GANESH, Asst.Prof, Dept. of Computer Science 
 

     1 
 

Microsoft PowerPoint 

Microsoft PowerPoint is a commercial presentation application written and distributed by Microsoft 

for Microsoft Windows and Mac OS X.Microsoft PowerPoint is a presentation tool that supports 

text, shapes, graphics, pictures and multimedia along with integration with other Microsoft Office 

products like Excel. By default, documents saved in PowerPoint are saved with 

the .pptx extension whereas, the file extension of the prior PowerPoint versions is .ppt. 

Opening Powerpoint 

Step 1 − Click the Start button. 

Step 2 − Click All Programs option from the menu. 

Step 3 − Search for Microsoft Office from the sub menu and click it. 

Step 4 − Search for Microsoft PowerPoint 2010 from the submenu and click it. 

This will launch the Microsoft PowerPoint 2010 application  

The following screenshot shows the various areas in a standard PowerPoint file. It is 
important to familiarize yourself with these areas as it makes learning and using PowerPoint 
easier. 
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File Tab 

This tab opens the Backstage view which basically allows you to manage the file and 
settings in PowerPoint. You can save presentations, open existing ones and create new 
presentations based on blank or predefined templates. The other file related operations 
can also be executed from this view. 

Ribbon 

 

The ribbon contains three components − 

 Tabs − They appear across the top of the Ribbon and contain groups of related 
commands. Home, Insert, Page Layout are examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below the 

group on the Ribbon. For example, a group of commands related to fonts or a group 
of commands related to alignment, etc. 

 Commands − Commands appear within each group as mentioned above. 

Title Bar 

This is the top section of the window. It shows the name of the file followed by the name of 
the program which in this case is Microsoft PowerPoint. 

Slide Area 

This is the area where the actual slide is created and edited. You can add, edit and delete 
text, images, shapes and multimedia in this section. 

Help 

The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on 
the "?" opens the PowerPoint Help window where you have a list of common topics to 

browse from. You can also search for specific topics from the search bar at the top. 

Zoom Options 

The zoom control lets you zoom in for a closer look at your text. The zoom control consists 
of a slider that you can slide left or right to zoom in or out, you can click on the - and + 
buttons to increase or decrease the zoom factor. The maximum zoom supported by 
PowerPoint is 400% and the 100% is indicated by the mark in the middle. 
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Slide Views 

The group of four buttons located to the left of the Zoom control, near the bottom of the 
screen, lets you switch between PowerPoint views. 

 Normal Layout view − This displays page in normal view with the slide on the right 
and a list of thumbnails to the left. This view allows you to edit individual slides and 
also rearrange them. 

 Slide Sorter view − This displays all the slides as a matrix. This view only allows 

you to rearrange the slides but not edit the contents of each slide. 

 Reading View − This view is like a slideshow with access to the Windows task bar 

in case you need to switch windows. However, like the slideshow you cannot edit 
anything in this view. 

Notes Section 

This sections allows you to add notes for the presentation. These notes will not be displayed 
on the screen during the presentation; these are just quick reference for the presenter. 

Quick Access Toolbar 

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient 
place to group the most commonly used commands in PowerPoint. You can customize this 
toolbar to suit your needs. 

Slide Tab 

This section is available only in the Normal view. It displays all the slides in sequence. You 
can add, delete and reorder slides from this section. 

Backstage View 

This view not only offers all the menu items under the file menu, but additional details which 
makes management of your files a lot easier. 

You can access the Backstage view simply by clicking on the File tab. You can exit this 
view by clicking on any tab (including the File tab again). You can also press the 'Esc' 
button on the keyboard. 

The backstage view has three sections or panes. 
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 First Pane − This is the commands pane which consists of all the commands you 

would typically find in the file menu of older versions. You also have 
the Options menu which lets you edit the options on the program like customizing 

the ribbon. 

Various commands under the first pane are described in the table below − 

S.No Command & Description 

1 
Save 

This allows you to save a new file or an existing file in standard format. If you are 
working on a previously saved file this will save the new changes in the same file 
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format. If you are working on a new file, this command would be similar to the Save 
As command. 

2 
Save As 

Allows you to specify the file name and the file type before saving the file. 

3 
Open 

Allows you to open new PowerPoint files. 

4 
Close 

Allows you to close an existing file. 

5 
Info 

Displays the information about the current file. 

6 
Recent 

Lists series of recently viewed or edited PowerPoint files. 

7 
New 

Allows you to create a new file using blank or pre-defined templates. 

8 
Print 

Allows you to select the printer settings and print the presentation. 

9 
Save & Send 

Allows you to share your presentation with larger audience via emails, web, cloud 
services, etc. 

10 
Help 
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Provides access to PowerPoint Help. 

11 
Options 

Allows you to set various options related to PowerPoint program. 

12 
Exit 

Closes the presentation and exits the program. 

 Second Pane − This is the subcommands pane. This will list all the commands 
related to the main command you choose in the first pane. For example, if you select 
Print in the first pane, you get to choose the printer and adjust the print settings in 
the second pane. 

 Third Pane − This is the preview or file information page. Depending on the 
command and the subcommand you select, this pane will either display the 
properties of the file or give you a preview of the file. 

Adding new slides to an existing presentation 

Step 1 − Right-click in the Navigation Pane under any existing slide and click on the New 
Slide option. 

Step 2 − The new slide is inserted. You can now change the layout of this slide to suit your 

design requirements. 

Step 3 − To change the slide layout, right-click on the newly inserted slide and go to 
the Layout option where you can choose from the existing layout styles available to you. 

When we insert a new slide, it inherits the layout of its previous slide with one exception. If 
you are inserting a new slide after the first slide (Title slide), the subsequent slide will have 
the Title and Content layout. 

Adding new text boxes 

Step 1 − Click on the Text Box icon in the Home ribbon under the Drawing section. 

Step 2 − You will get the insert text box cursor that looks like an inverted cross. 

Step 3 − Click to insert a text box. You can now start typing directly into the text box. 

Step 4 − Alternately, you can click and drag the cursor without releasing the click to create a text 

box. 
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Deleting a slide 

Step 1 − Go to the Normal view. 

Step 2 − Right-click on the slide to be deleted and select the Delete Slide option. 

Alternately, you can select the slide and press the Delete button on your key board. 

Rearranging slides 

Step 1 − Select the slide to be moved. 

Step 2 − Left click on the slide and drag it to the position in the sequence where you want 

to place it. PowerPoint will indicate the insert position with a line in-between existing slides. 

Step 3 − When you get to the right position release the left click button to insert the slide. Alternately 

you can also cut the selected slide and paste it back in the sequence  

Adding slide notes 

Slide notes can be very useful tools for presentation. These notes are not displayed on the screen 
in the Slideshow mode, but the presenter can see them so they can prepare well to present the 
slides.  

Step 1 − To locate the slide notes, set the view in Normal mode. 

Step 2 − The Slide Notes section is indicated by "Click to add notes". 

Step 3 − You can click on the top border and drag the section to increase its size to make it easier 

to type. 

Step 4 − Type your text in this section as slide notes. 

Setting background in slides 

As PowerPoint is a design-based program, backgrounds are effective ways of improving the 
aesthetics and readability of the slides. The Themes in PowerPoint help select the backgrounds by 

default, so every time you change the theme, the default background is set automatically. Theme 
includes more than just backgrounds, so you can retain other aspects of the theme while changing 
the default background. 

Step 1 − In the Design ribbon, under the Background group, click the Background 
Styles command. 

Step 2 − Select one of the background styles that suits your requirements. 

Step 3 − To edit the background for a specific slide, right-click on the desired background slide and 
select "Apply to Selected Slides". 

Step 4 − Selected slide(s) now have the new background. 
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Saving presentation 

Step 1 − Click on the File tab to launch the Backstage view and select Save. 

Step 2 − In the Save As dialog, type in the file name and click "Save". 

Slide numbering 

Step 1 − Under the Insert ribbon, Text group click on Slide Number command. 

Step 2 − The Header and Footer dialog opens up. 

Step 3 − Check the Slide number check box. 

Step 4 − The Preview shows the section where the slide number will be placed. 

Instead of clicking on the Slide Number command, you can also click on the Header & 
Footer menu item to launch the same dialog as in Step 2. 

Adding header and footer 

Step 1 − In the Insert ribbon, click on the Header & Footer menu item. 

Step 2 − The Header and Footer dialog has two tabs — the Slide tab and the Notes and 
Handouts tab. 

Step 3 − You can add details to the slide footer from the Slide tab. 

Running slide show 

Features related to running the slideshow are grouped under the Slideshow ribbon. 

Section Menu Item Description 

Start Slideshow From Beginning Starts slideshow from beginning 

From Current Slide Starts slideshow from the current slide 

Broadcast Slideshow 
Allows users to broadcast the slideshows 
using Microsoft's PowerPoint Broadcast 
Service 

Custom Slideshow 
Builds a custom slideshow by picking the 
slides you want to run 
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Set Up 

Set Up Slideshow 

Helps set up the slideshow including browser/ 
full screen display, show options with or 
without narration/ animation, pen and laser 
color during the slideshow and the slides to be 
presented during the show 

Hide Slide 
Helps mark/ unmark the slide as hidden, so it 
is skipped or shown during the slideshow 
respectively 

Rehearse Timing 
Allows users to rehearse the timing on each 
slide and the entire slideshow 

Record Slideshow 
Records the slideshow including narration and 
animation 

Slideshow Checkboxes 
Helps set or avoid the use of narrative audio 
and rehearsed timings during the show. 
Display media controls in the slideshow view 

Monitors Resolution Defines resolution in slideshow view 

Show Presentation on 
Picks the monitor to display the presentation 
one - in case of multiple monitors 

Use Presenter View 
Run presentation in Presenter view rather 
than just slideshow view 

Formatting presentation 

 Font management 
PowerPoint offers extensive font management features to cover various aspects of fonts. 
The font management can be accessed from the Home ribbon in the Font group. 

You can also access font management features by selecting a text box, right-clicking and 
selecting Font. 
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S.No Features & Description 

1 
Font Type 

Defines the font type like Arial, Verdana, etc. 

2 
Font Size 

Defines the font size. Besides, there are icons to increase and decrease the font 
size in steps in the Font group. 

3 
Font Style 

Defines font styles like Regular, Bold, Italics or Underlined. 

4 
Font Color 

Specifies the font color. 

5 
Font Effects 

Defines effects like shadow, strikethrough, subscript, superscript, etc. 

6 
Character Spacing 

Specifies character spacing like loose, tight, normal, etc. 

 

 Setting text font 
Step 1 − The default font in PowerPoint 2010 is Calibri. 
Step 2 − To change the text font, select that portion of text the font of which needs to be 

changed. If you select the entire text box or shape, the changes will apply to all the text in 
the selection. If you select specific text, the changes will apply to selection only. 
Step 3 − In the Font group, under the Home ribbon, click on the font face dropdown. 
Step 4 − Scroll through the list of font faces to pick the one that suits your needs. As you 

move your cursor over the fonts, the selection will change accordingly to give you a preview. 

 Text decoration 
PowerPoint offers many text decoration features and adds to the aesthetic sense of a 
presentation. These features can be accessed from the Home ribbon under the Font group. 
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S.No Icon & Description 

1 

 

Makes the font face bold 

2 

 

Makes the font face italics (slanted font) 

3 

 

Underlines the font face 

4 

 

Adds shadow to the font face 

5 

 

Strikes through the font face 

6 

 

Adjusts the character spacing for the font. Predefined settings are very tight, tight, 
normal, loose and very loose. There is a user defined space setting available too. 

Besides these, there are some other font decoration features that can be accessed from 
the Font dialog. To open the Font dialog, right-click on the selected text and select Font. 

The table below describes the additional text decoration features in the Font dialog. 
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S.No Icon & Description 

1 
Double Strikethrough 

Adds two strike lines over the text 

2 
Superscript 

Raises the text above the normal text. For example, the use of "nd" in 2nd 

3 
Subscript 

Shrinks the below the normal text. For example, the '2' in H2O the chemical formula 
of water 

4 
Small Caps 

Changes the entire text to small caps 

5 
All Caps 

Changes the entire text to capital letters 

6 
Equalize Character height 

Adjusts the characters so that all are of the same height regardless of the caps 
setting 

 

 Change text case 
Step 1 − Select the text the case of which you want to change. 
Step 2 − Go to the Font group under the Home ribbon. 
Step 3 − From the Change Case dropdown, select the case you want to use for your text. 
Step 4 − Click on your choice to change case for the selected text. 

 

 Change text color 
Step 1 − Select the text the color of which needs to be changed. 
Step 2 − Go to the Font group under the Home ribbon. 
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Step 3 − From the Font Color dropdown, select the color you want to use for your 
text. 

Step 4 − Click on your choice to change the font color for the selected portion of text. 

 

 Change text size 
Step 1 − Select the text the case of which you want to change. 
Step 2 − Go to the Font group under the Home ribbon. 
Step 3 − From the Font Size dropdown, select the size you want to use for your text. 
Step 4 − Click on your choice to change the font size for the selected portion of text 
Step 5 − If you want to change the font size in steps you can also use the Increase/ 
Decrease Font Size options. 

 

 Text alignments 

 The table below describes the various text alignment options available in 
PowerPoint. 

S.No Alignment Icon & Description 

1 

 

Aligns the text to the left of the shape/ text box. 

2 

 

Aligns the text in the middle of the shape/ text box. 

3 

 

Aligns the text to the right of the shape/ text box. 

4 

 

Justifies the alignment by adjusting the character spacing so the final text looks 
aligned from both left and right. 
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5 

 

Specifies text direction: horizontal (default), stacked (vertical), rotated by 90 or 270 
degrees. You can also customize the text direction to other angles. 

6 

 

Vertically aligns the text; top, bottom or middle of the text box/ shape 

Step 1 − Select the portion of text that needs to be aligned. If you select a specific portion 

of text, the alignment settings will apply to that portion of text alone. If you select the entire 
shape/ text box, the settings will apply for the entire selection. 

Step 2 − Go to the Paragraph group under the Home ribbon. 

Step 3 − Select one of the alignment options described above to change the text alignment. 

Note that the default alignment for text is usually Left. 

Step 4 − As long as the text is selected, you can change the text alignment multiple times. 

 

 Indent paragraph 
Step 1 − Select the text content to be indented. Unlike most other settings, 

indentation works at a paragraph level, so regardless of what text you select the 
indent settings will apply to the entire paragraph. However, if the text box has 
multiple paragraphs you can have different indentations for different paragraphs. 
Step 2 − Go to the Paragraph group under the Home ribbon. 
Step 3 − Select one of the indentation options. You will notice that by default the text is set 
at the lowest indentation level, so you will not be able to decrease it further. You must 
increase indentation the first time you use it. 
Step 3 − Select one of the indentation options. 
Step 4 − Once you have increased the indent, the decrease indent option is enabled. 
 

 Line spacing 
Step 1 − Select the text content to be spaced. You can either select the entire 
paragraph or just place the cursor within the paragraph. 
Step 2 − Go to the Paragraph group under the Home ribbon. 
Step 3 − Select one of the line spacing option from the dropdown list to apply one of 

predefined spacing options. 
Step 4 − To customize the spacing, you can click on "Line Spacing Options…" This will 
launch the Paragraph dialog 
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Step 5 − The spacing section in the Paragraph dialog has two settings. 
The Before and After are the spacing for paragraph as a whole, while Line Spacing is the 

spacing for lines within the paragraph itself. 

 

 Borders and shades 
The following are the steps that will help you apply borders in your presentation. 
Step 1 − Select the object (text box, image, chart, picture, etc.) to which you want to 
apply the border. 
Step 2 − Go to the Drawing group under the Home ribbon. 

Step 3 − Click on the Shape Outline to choose the border settings. 

Step 4 − Use the color palette to choose the border color. You can choose More 
Outline Colors to get access to additional color choices 

Step 5 − Use the Weight dropdown to define the thickness of the border. 

Step 6 − Use the Dashes option to define the border style. 

The following steps will help you apply shades to your presentation. 

Step 1 − Select the object (text box, shape, chart, etc.) to which you want to apply 

the shades. 

Step 2 − Go to the Drawing group under the Home ribbon. 

Step 3 − Click on the Shape Fill to choose the shade settings. 

Step 4 − Use the color palette to choose the shade color. You can choose More 
Outline Colors to get access to a choice of colors. 

Step 5 − Use the Picture to add a picture as the background rather than a color. 

Step 6 − Use the Gradient option to add color gradient in the background. You can 
use the pre-defined gradients or click on "More Gradients…" to customize the 

shading with gradient colors. 

Step 7 − Use the Texture option to add a pre-defined texture instead of a color shade 

Working with Multimedia 

Add pictures to slide 

PowerPoint supports multiple content types including images or pictures. With regards to 
pictures PowerPoint classifies them into two categories − 

 Picture − Images and photos that are available on your computer or hard drive 

 Clip Art − Online picture collection that you can search from the clip art sidebar 

Although their sources are different, both these types can be added and edited in similar 
fashion. 
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Step 1 − Go to the Images group in the Insert ribbon. 

Step 2 − Click on Picture to open the Insert Picture dialog and add a picture to the slide. 

Step 3 − In this dialog, you have three sections: to the left corner, you have folders that can 

be browsed, the section in the center shows the subfolders and files in the selected folder 
and to the right, you can have a preview of the selected image. 

Step 4 − Select the image you want and click Open to add the picture to the slide. 

Step 5 − To add online pictures, click on Clip Art and search for keywords in the Clip Art sidebar. 

Step 6 − Once you have the clipart you want to use, double-click on the image to add it to the 

slide. 

Editing added pictures 

PowerPoint supports images or pictures as content and offers some standard image editing 

features. The picture editing features in PowerPoint can be accessed from the Format ribbon once 

the picture is selected. The editing features are grouped under the Adjust and Picture 

Styles section in the Format ribbon. 

The following table describes various picture adjustment features available in PowerPoint. 

S.No Feature & Description 

1 
Remove Background 

Automatically removes the unwanted sections in the image. This is similar to the 
magic tool in some of the other photo editing programs. You can click on different 
regions on the image to define the area to be removed. 

2 
Correction 

Allows you to change the brightness and contrast on the image and also change the 
image sharpness. 

3 
Color 

Allows you to change the color on the image by changing the saturation or tone. You 
can also make the image monochromatic based on different hues to match the 
theme of your presentation. 
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4 
Artistic Effects 

Adds artistic effects to the image like plastic wrap, glowing edges, etc. 

5 
Compress Picture 

This can change the image resolution to manage the file size. 

6 
Change Picture 

Replaces the current picture with a different one. 

7 
Reset Picture 

Removes all the adjustments done on the image. 

Picture Styles 

The following table describes various picture style features available in PowerPoint. 

S.No Feature & Description 

1 
Picture Border 

Manages the picture border - color, weight and style. 

2 
Picture Effects 

Adds effects to the picture like reflection, shadow, etc. 

3 
Convert to SmartArt Graphic 

Transforms the picture into the selected SmartArt. 

4 
Quick Styles 

Pre-defined styles with different picture borders and effects. 
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Format added pictures 

The picture formatting features in PowerPoint can be accessed from the Format ribbon once the 

picture is selected. The formatting features are grouped under the Arrange and Size section in 

the Format ribbon. 

The following table describes various picture arrangement features available in 
PowerPoint. 

S.No Feature & Description 

1 
Bring Forward 

Moves the picture layer up. Bring Forward moves the picture up by one layer, Bring 

to Front makes the picture layer the topmost 

2 
Send Backward 

Moves the picture layer down. Send Backward moves the picture down by one 
layer, Send to Back makes the picture layer the bottommost 

3 
Selection Pane 

This opens up the Selection Pane sidebar where you get a better idea of the layers 
and can work with arrangements better. 

4 
Align 

Aligns the picture with various references in the slide. 

5 
Group 

Allows multiple images to be grouped together to create on single object or ungroup 
them to split them into individual pictures. 

6 
Rotate 

Rotate picture by a specific angle. 

The following table describes various picture sizing features available in PowerPoint. 
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S.No Feature & Description 

1 
Crop 

Allows you to crop the image. The cropping can be freehand, based on aspect ratio 
or any of the predefined shapes. 

2 
Shape Height/ Width 

Used to change the height and width of the image. When you edit these parameters 
from the ribbon, the aspect ratio is always maintained. 

 

Inserting screenshot 

One of the interesting features about PowerPoint is that you can insert a screenshot of one 
of your applications into your presentation without having to use any other program. Given 
below are the steps to insert a screenshot. 

Step 1 − Go to the Images group in the Insert Ribbon. 

Step 2 − Click on the Screenshot dropdown to look at full screen snaps of all the applications 

running on your computer’s desktop. 

Step 3 − Select one of the screenshots to add it directly on to your presentation. 

Step 4 − If you do not want the entire screen and just a portion of it, you can use the Screen 

Clipping option. 

Adding shapes to slide 

Step 1 − Go to the Illustrations group under the Insert Tab. 

Step 2 − Click on the Shapes dropdown to view the available shapes. 

Step 3 − Select the shape you want to insert. This will change the cursor to a + sign. 

Step 4 − Click and drag on the slide to create the shape. As you drag, the shape will show 

up on the slide. Continue to drag and adjust the size and the symmetry of the shape. 

Editing added shapes 

The shape editing features in PowerPoint can be accessed from the Format ribbon once the 

shape is selected. The editing features are grouped under the Insert Shapes and the Shape 

Styles section in the Format ribbon. 
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S.No Feature & Description 

1 
Shape List 

Adds another shape to the slide. 

2 
Edit Shape 

Replaces the shape completely, or use the edit points to change the existing shape. 

3 
Text Box 

Inserts a text box anywhere in the slide. 

The table below describes various shape style features available in PowerPoint. 

S.No Feature & Description 

1 
Shape Fill 

Selects the shape fill color and style. You can add a single solid color from the 
palette, or a picture, gradient or texture. 

2 
Shape Outline 

Selects the shape border color, thickness and style. 

3 
Shape Effects 

Adds special effects to the shape like reflection, 3D rotation, bevel, shadow, etc. 

4 
Predefined Styles 

These are a combination of the style features that can be applied to the shape with 
a single click. 
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Format added shapes 

The shape formatting features in PowerPoint can be accessed from the Format ribbon once the 

shape is selected. The formatting features are grouped under the Arrange and Size section in 

the Format ribbon. 

The table given below describes the various shape arrangement features available in 
PowerPoint. 

S.No Feature & Description 

1 
Bring Forward 

Moves the shape layer up. Bring Forward moves the shape up by one layer, Bring 
to Front makes the shape layer the topmost. 

2 
Send Backward 

Moves the shape layer down. Send Backward moves the shape down by one 
layer, Send to Back makes the shape layer the bottommost. 

3 
Selection Pane 

This opens up the Selection Pane sidebar where you get a better idea of the layers 
and can work with arrangements better. 

4 
Align 

Aligns the shape with various references in the slide. 

5 
Group 

Allows multiple shapes to be grouped together to create on single object or ungroup 
them to split them into individual shapes. 

6 
Rotate 

Rotates shape by a specific angle. 

The table given below describes various shape sizing features available in PowerPoint. 
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S.No Feature & Description 

1 
Shape Height/ Width 

Used to change the height and width of the shape. When you edit these parameters 
from the ribbon, the aspect ratio is always maintained 

 

Adding text to shapes 

Step 1 − Right-click on the shape to which you want to add the text and select the Edit 

Text option. 

Step 2 − Start typing the text into the shape. Once you are done, click the cursor anywhere outside 

the shape. 

An alternative way of adding text to shape is to select the shape and start typing directly. Once you 

have the text within the shape you can format the text using the font related features available in 

PowerPoint. 

Adding audio and video 

Step 1 − Go to the Media group under the Insert ribbon 

Step 2 − To insert video file select Video as media type and Video from File to insert a video from 

your computer or hard drive. 

Step 3 − In the Insert Video dialog, browse for a video file and click Insert. 

Step 4 − You will now see that a Video file is added to the slide 

Step 5 − To insert audio file select Audio as media type and Audio from File to insert an Audio 

from your computer or hard drive. 

Step 6 − In the Insert Audio dialog, browse for an audio file and click Insert 

Step 7 − You will now see that an Audio file is added to the slide. 

Add and format tables 

The following steps will help you add a table in PowerPoint. 

Step 1 − Go to the Tables group under the Insert ribbon. 

Step 2 − Click on the dropdown and select your table dimension from the matrix. 

Step 3 − If you require more than 10 columns or 8 rows click on "Insert Table" to open the Insert 

Table dialog where you can specify the column and row count. 
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PowerPoint table is a simple table that does not support the mathematical features of an Excel 

spreadsheet. If you want to carry out some calculations, you can insert an Excel 

spreadsheet instead of a regular table. 

This will insert the spreadsheet in the slide and as long as the spreadsheet is selected, the ribbon 

at the top will be changed to an Excel ribbon instead of a PowerPoint one 

The PowerPoint table formatting features have been grouped under two 

ribbons: Design and Format. The sections below discuss the features under each ribbon. To 

access these ribbons, you must select the table first. 

The following table shows the different table design features − 

Feature Sub Features Description 

Table Style Options 
Header Row 

Adds a different shade to the first row to 
distinguish it. 

Total Row 
Adds a different shade to the last row to 
distinguish it. 

Banded Rows 
Shades alternate rows in the table with the same 
color. 

First Column 
Adds a different shade to the first column to 
distinguish it. 

Last Column 
Adds a different shade to the last row to 
distinguish it. 

Banded Columns 
Shades alternate columns in the table with the 
same color. 

Table Styles 
Shading 

Offers different shades to be added to selected 
table/ row/ column/ cell. You can pick from solid 
shade, texture, image or gradient shading. 
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Border 
Offers different border options for the table. You 
can edit the border color, thickness and style 

Effects 
Offers the ability to create table shadow or 
reflection. You can also create bevels for 
individual cells. 

Word Art Styles 
Text Fill 

Allows you to change the color of the text within 
the table. 

Text Outline 
Allows you to add an outline to the text within the 
table and change the outline color, weight and 
style. 

Text Effects 
Allows you to add special effects (like reflection, 
shadow etc.) to the text within the table. 

Quick Styles 
Contains a list of pre-defined Word Art styles that 
can be applied to the selected text within the 
table with a single click. 

Draw Borders 
Pen Style 

Defines the style of the table border when you 
draw it. 

Pen Weight 
Defines the thickness of the table border when 
you draw it. 

Pen Color 
Defines the color of the table border when you 
draw it. 
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Draw Table 
Allows you to append new rows, columns, cells to 
existing table, split existing rows, columns or cells 
and draw brand new tables. 

Eraser 
Allows you to delete table borders and merge 
cells, rows or columns. 

We will now understand the various table format features in PowerPoint. 

Feature Sub Features Description 

Table 
Select 

Allows you to select the entire table or the 
row(s) or column(s) depending on the position 
of your cursor. 

View Gridlines Toggles the gridline display within the table. 

Rows & Columns 
Delete 

Allows you to delete selected row(s) or 
column(s) or the entire table. 

Insert Above 

Inserts a row above the row where the cursor is 
currently. If you haven't placed the cursor within 
the table, it adds a new row at the top of the 
table. 

Insert Below 

Inserts a row below the row where the cursor is 
currently. If you haven't placed the cursor within 
the table, it adds a new row at the bottom of the 
table. 

Insert Left Inserts a column to the left of the column where 
the cursor is currently. If you haven't placed the 
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cursor within the table, it adds a new column to 
the left of the table. 

Insert Right 

Inserts a column to the right of the column 
where the cursor is currently. If you haven't 
placed the cursor within the table, it adds a new 
column to the right of the table. 

Merge 
Merge 

Allows you to merge cells, rows or columns. 
This is enabled only if you have selected more 
than one cell, row or column. 

Split Cells 
Allows you to specify the number of rows and 
columns into which the current section of cell(s) 
need to be split. 

Cell Size 

Height/ Width 

Defines the height and width of the selected 
cell. Usually if you change these aspects for a 
single cell, the change affects the entire row or 
column too. 

Distribute Rows 
Equalizes the height of all the rows to fit the 
current table height. 

Distribute Columns 
Equalizes the width of all the columns to fit the 
current table width. 

Alignment 
Horizontal Alignment 

Allows you to align the selected text to the left, 
right or center of the cell. 

Vertical Alignment 
Allows you to align the selected text to the top, 
bottom or middle of the cell. 
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Text Direction 
Allows you to change the direction of the 
selected text within the cells. 

Cell Margins Allows you to define the margins within the cell. 

Table Size 
Height 

Allows you to adjust the table height - it retains 
the relative heights of the individual rows while 
changing the overall table height. 

Width 
Allows you to adjust the table width - it retains 
the relative widths of the individual columns 
while changing the overall table width. 

Lock Aspect Ratio 
Checking this box will ensure the ratio between 
the table height and width is maintained when 
one of these is changed. 

Arrange 
Bring Forward 

Allows you to move the table up by one layer or 
right to the top. 

Send Backward 
Allows you to move the table down by one layer 
or right to the bottom of the slide. 

Selection Pane Toggles the Selection and Visibility sidebar. 

Align 
Allows you to align the entire table with 
reference to the slide. 

 

Add and format charts 

 PowerPoint supports the addition and formatting of charts. 

Given below are the steps to add a chart to PowerPoint. 
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Step 1 − Go to the Illustrations group under the Insert ribbon. 

Step 2 − Click on the Chart option to open the Insert Chart dialog. You can choose the chart 

category and pick individual chart types from the list. 

Step 3 − Select the chart type and click OK or double-click on the chart type to insert the chart in 
the slide. 

Step 4 − Along with the chart, an Excel spreadsheet is also launched. This spreadsheet is the 

source for your chart. You can change the category names, series names and individual values to 
suit your needs. 

As you edit the values and the table in Excel the chart gets modified accordingly. 

The PowerPoint chart formatting features have been grouped under three 
ribbons: Design, Layout and Format. 

We will now understand the various chart design features in PowerPoint. 

Feature Sub Features Description 

Type Change Chart Type Changes the chart type retaining the same data. 

Save As Template Saves current chart type as a template. 

Data 
Switch Row/Column 

Transposes current excel data - this is enabled 
when you have the source data excel sheet open. 

Select Data Changes the data range covered in the chart. 

Edit Data Changes the chart source data. 

Refresh Data Refreshes the chart to show the latest data. 

Chart Layouts 
Chart Layouts 

Offers a list of predefined layouts which can be 
instantly applied to current chart with a single click. 
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Chart Styles 
Chart Styles 

Offers a list of predefined styles which can be 
instantly applied to current chart with a single click. 

We will now understand the various chart layout features in PowerPoint. 

Feature Sub Features Description 

Current Selection Drop down Shows the currently selected chart element. 

Format Selection 
Shows the selection format dialog to update 
the selection. 

Reset to Match Style 
Discards all the chart customizations and 
matches the chart with the overall presentation 
theme. 

Insert Picture Superimposes an image on top of the chart. 

Shape Adds a shape to the slide. 

Text Box Adds a text box to the slide. 

Labels 
Chart Title 

Defines the visibility, position and style of the 
chart title. 

Axis Titles 
Defines the visibility, position and style of the 
axis titles. 

Legend 
Defines the visibility and position of the chart 
legend. 
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Data Labels 
Defines the visibility and position of the data 
labels. 

Data Table 
Defines the visibility, position and format of the 
data table. 

Axes Axes Defines the position and scale of axes. 

Gridlines Defines the visibility and scale of axes. 

Background 
Plot Area 

Toggles chart plot area - available only for 2D 
charts. 

Chart Wall 
Toggles the chart wall - available only for 3D 
charts. 

Chart Floor 
Toggles the chart floor - available only for 3D 
charts. 

3-D Rotation 
Toggles the chart 3D rotation- available only 
for 3D charts. 

We will now understand the various chart format features in PowerPoint. 

Feature Sub Features Description 

Current Selection Drop down Shows the currently selected chart element. 

Format Selection 
Shows the selection format dialog to update 
the selection. 
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Reset to Match Style 
Discards all the chart customizations and 
matches the chart with the overall presentation 
theme. 

Shape Styles 
Shape Fill 

Offers different shades to be added to selected 
chart series item. You can pick from solid 
shade, texture, image or gradient shading. 

Border 
Offers different border options for selected 
chart series item. You can edit the border color, 
thickness and style. 

Effects 
Offers the ability to add special effects to 
selected chart series item. 

Word Art Styles 
Text Fill 

Allows you to change the color of the text 
within the chart. 

Text Outline 
Allows you to add an outline to the text within 
the chart and change the outline color, weight 
and style. 

Text Effects 
Allows you to add special effects (like 
reflection, shadow etc.) to the text within the 
chart. 

Quick Styles 
Contains a list of pre-defined Word Art styles 
that can be applied to the selected text within 
the chart with a single click. 

Arrange 
Bring Forward 

Allows you to move the chart up by one layer 
or right to the top. 



MS POWERPOINT-INRODUCTION                             Chapter- MS Powerpoint              

Module-2 

 

Mrs.VARSHA GANESH, Asst.Prof, Dept. of Computer Science 
 

     32 
 

Send Backward 
Allows you to move the chart down by one 
layer or right to the bottom of the slide. 

Selection Pane Toggles the Selection and Visibility sidebar. 

Align 
Allows you to align the entire chart with 
reference to the slide. 

Group 
Allows you to group multiple charts as one 
group object, or split a group object into 
individual charts. 

Size Height Allows you to adjust the chart height. 

Width Allows you to adjust the chart width. 

Add and format Smart art 

PowerPoint offers a unique feature called SmartArt which allows users to add text to predefined art 
designs. The advantage with SmartArt is that although each component of the SmartArt can be 
edited individually, you can also modify the SmartArt as a whole while retaining the settings on each 
individual component. 

Step 1 − Go to the Illustrations group under the Insert ribbon. 

Step 2 − Click on the SmartArt command to open the Choose a SmartArt Graphic dialog. You 

can choose the SmartArt category and pick individual SmartArt types from the list. You also get a 
preview and a short description of the graphic in the preview section. 

Step 3 − Select the SmartArt type and click OK or double-click on the SmartArt type to 

insert the graphic in the slide. 

Step 4 − The graphic is inserted in the slide along with a text pane where you can enter/ 

modify the SmartArt text. 

Step 5 − Add the necessary details and close the text pane to complete the SmartArt insertion. 

The PowerPoint SmartArt formatting features have been grouped under two 
ribbons: Design and Format. The sections below discuss the features under each ribbon. 

We will now understand the various SmartArt design features in PowerPoint 
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Feature Sub Features Description 

Create Graphic 
Add Shape 

Adds another shape to the current SmartArt graphic; 
this also adds another bullet in the text pane. 

Add Bullet 
Adds another bullet in the text pane; this also adds 
another shape to the graphic. 

Text Pane Toggles text pane visibility. 

Promote 
Indents bullet to higher level in text pane - useful only 
in multi-level SmartArt. 

Demote 
Indents bullet to lower level in text pane - useful only in 
multi-level SmartArt. 

Right to Left Helps reverse the direction of the SmartArt flow. 

Move Up 
Moves the bullet up in the text pane or the shape to 
the left in the graphics. 

Move Down 
Moves the bullet down in the text pane or the shape to 
the right in the graphics. 

Layouts 
Layouts 

Allows you to change the layout of SmartArt graphics 
to one from the list. 

Smart Styles Change Colors Changes the color scheme for the SmartArt graphics. 
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SmartArt Styles 
Allows you to change the SmartArt graphics styles to 
one of the predefined ones from the list with one click. 

Reset 
Reset Graphic 

Removes all the customization done on the SmartArt 
graphic. 

Convert 
Converts SmartArt graphic to regular shapes or plain 
text. 

We will now understand the various SmartArt format features in PowerPoint. 

Feature Sub Features Description 

Shapes 
Change Shape 

Changes the selected shape in the SmartArt to one of 
those in the list. 

Larger Increases the size of the selected shape. 

Smaller Decreases the size of the selected shape. 

Shape Styles 
Shape Fill 

Offers different shades to be added to selected 
SmartArt graphics item. You can pick from solid shade, 
texture, image or gradient shading. 

Border 
Offers different border options for selected SmartArt 
graphics item. You can edit the border color, thickness 
and style. 

Effects 
Offers the ability to add special effects to selected 
SmartArt graphics item. 
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Word Art Styles 
Text Fill 

Allows you to change the color of the text within the 
SmartArt. 

Text Outline 
Allows you to add an outline to the text within the 
SmartArt and change the outline color, weight and 
style. 

Text Effects 
Allows you to add special effects (like reflection, 
shadow etc.) to the text within the SmartArt. 

Quick Styles 
Contains a list of pre-defined Word Art styles that can 
be applied to the selected text within the SmartArt with 
a single click. 

Arrange 
Bring Forward 

Allows you to move the SmartArt up by one layer or 
right to the top. 

Send Backward 
Allows you to move the SmartArt down by one layer or 
right to the bottom of the slide. 

Selection Pane Toggles the Selection and Visibility sidebar. 

Align 
Allows you to align the entire SmartArt with reference 
to the slide. 

Group 
Allows you to group multiple SmartArt as one group 
object, or split a group object into individual SmartArt. 

Size Height Allows you to adjust the SmartArt height. 

Width Allows you to adjust the SmartArt width. 
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Sub Features Description 

Change Shape Changes the selected shape in the SmartArt to one of 
those in the list. 

Larger Increases the size of the selected shape. 

Smaller Decreases the size of the selected shape. 

Shape Fill Offers different shades to be added to selected 
SmartArt graphics item. You can pick from solid shade, 
texture, image or gradient shading. 

Border Offers different border options for selected SmartArt 
graphics item. You can edit the border color, thickness 
and style. 

Effects Offers the ability to add special effects to selected 
SmartArt graphics item. 

Text Fill Allows you to change the color of the text within the 
SmartArt. 

Text Outline Allows you to add an outline to the text within the 
SmartArt and change the outline color, weight and 
style. 

Text Effects Allows you to add special effects (like reflection, 
shadow etc.) to the text within the SmartArt. 
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Quick Styles Contains a list of pre-defined Word Art styles that can 
be applied to the selected text within the SmartArt with 
a single click. 

Bring Forward Allows you to move the SmartArt up by one layer or 
right to the top. 

Send Backward Allows you to move the SmartArt down by one layer or 
right to the bottom of the slide. 

Selection Pane Toggles the Selection and Visibility sidebar. 

Align Allows you to align the entire SmartArt with reference 
to the slide. 

Group Allows you to group multiple SmartArt as one group 
object, or split a group object into individual SmartArt. 

Height Allows you to adjust the SmartArt height. 

Width Allows you to adjust the SmartArt width. 

 

Add and preview animations 

PowerPoint offers animation support which can be used effectively to add some motion in a 

monotonous presentation and make it more interesting. Animation can be applied to any object on 

the slide and the motions can the automated, timed or trigger. 

Step 1 − Go to the Animation ribbon and click on the Animation Pane to display the animation 

sidebar. 

Step 2 − Select one of the objects in the slide and click on the Add Animation menu option. 

Step 3 − Choose from one of the Animation options. 
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 Entrance will cause the object to appear in the screen. 

 Emphasis will cause the object to emphasis without appearing or leaving the screen. 

 Exit will cause the object to disappear from the screen. 

Step 4 − Once you add the animation for an object, it will show up in the Animation pane. 

Step 5 − By default, all the animations are initiated by a click, but you can change this. To change 

the trigger, right-click on the animation object on the pane and choose an alternate trigger. 

 Start On Click will cause the animation to start when you click the mouse. 

 Start With Previous will cause the animation to begin with the previous animation; 
if this is the first object, it will begin as soon as you reach the slide during the slide 
show. 

 Start After Previous will cause the animation to begin after the previous animation 

ends. 

Step 6 − From the timing section, you can also manipulate the animation timings. 

Step 7 − To preview the animation settings, just click Play on the animation pane. 

Add and preview Transitions 

PowerPoint supports slide transition feature which allows you to specify how should the 
slides transition during the slide show. 

Given below are the steps to add and preview slide transitions. 

Step 1 − Select the slide to which you want to apply the transition. 

Step 2 − Go to the Transition Scheme under the Transitions ribbon. 

Step 3 − Select one of the transition schemes from the list available. PowerPoint will instantly show 

you a preview of the scheme. If you are not satisfied, you can pick an alternate scheme. The last 
selected scheme will apply to the slide. 

Step 4 − You can change the effects on the selected transition scheme from the Effect 
Options menu. Every scheme has a unique set of effect options. 

Step 5 − You can also modify the transition timing settings from the Timing section. 

Step 6 − To preview the slide transition, click on Preview. 

Creating a PDF file 

Although PowerPoint is used to create presentations, it supports various file types when it comes to 
saving the content. With a host of operating systems and Office versions available in the market, 
using a pdf file type can be a great way of ensuring everyone sees the same slides. 

Step 1 − Go to the Backstage view under the File tab. 
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Step 2 − Click on Save As to open the Save As dialog. 

Step 3 − Select the file type as .pdf from the list of supported file types. 

Step 4 − Add a proper name to the file and click Save. 

Step 5 − The .pdf file is created in the specified location 

Create a video file 

PowerPoint allows presentations to be saved as video files that can be posted on video 
sharing platform like YouTube or just played on any other media. 

Given below are the steps to save a presentation as a video file. 

Step 1 − Go to the Backstage view under the File tab 

Step 2 − Click on Save As to open the Save As dialog. 

Step 3 − Select the file type as .wmv from the list of supported file types. 

Step 4 − Add a proper name to the file and click Save. 

Step 5 − Once the creation is complete, the video file is created in the specified location. 

Printing presentation 

It is sometimes necessary that you share your slides with your audience in printed format 
before you begin presenting them so they can take notes. There are other times when you 
want to give your audience handouts with additional notes. 

To print slides, you must go to the Backstage view under the File tab and click on 
the Print menu. 

Main Settings Options Description 

Printing Slides Print All Slides Prints all the slides in the presentation. 

Print Selection Prints just the selected objects. 

Print Current Slide Prints just the selected slide. 

Custom Range Defines the slides you want printed. 
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Slides This is same as the Custom Range. 

Print Layout Full Page Slides One slide per page. 

Notes Page 
Slide and notes for every slide printed one below 
another - one slide per page. 

Outline Print Slide outline. 

Handouts 

Prints 1 or 2 or 3 or 4 or 6 or 9 slides per page - 
aligned vertically or horizontally. When you print 
handouts with 3 slides, you get the slide and the 
notes printed next to each other. 

Collation 
Collating Options 

Prints slides in sequence or prints multiple copies of 
each slide one after another. 

Printing Color 

Color 

Selects color, greyscale or black & white printing 
options. Although you can select any color settings, 
the output will depend on the kind of printer you 
use. A non-color printer cannot print color slides. 

 

Broadcast slide show 

PowerPoint 2010 offers users to broadcast their presentations on the internet to worldwide 
audience. Microsoft offers the free broadcast Slide Show service; all you need to do is 
share the link with your audience and they can watch the presentation from anywhere. 
There is no special setup or charges required to do this; all you need is a Windows Live 
account. 

Given below are the steps to broadcast your presentation. 

Step 1 − Go to the Backstage view under the File tab. 

Step 2 − Click on Save & Send, select Broadcast Slide Show option and click 
on Broadcast Slide Show button. 
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Step 3 − In the Broadcast Slide Show dialog, click on Start Broadcast. 

Step 4 − Log on to your Windows Live account in the login dialog. 

Step 5 − Once the login is successful, PowerPoint will prepare the presentation for 
broadcast. 

Step 6 − PowerPoint will provide the broadcast service link which you can share with your 
audience. If you are not using Outlook service, click on "Copy Link" to paste the link in 
your emails. If you are using Microsoft Outlook service, click on "Send in Email" and list 
the names of your audience. 

Step 7 − Click on Start Slideshow to begin the presentation. 

Step 8 − When you are done, you can click on the End Broadcast to stop the online presentation. 

 

 

 


